Politechnika £6dzka

27 . S .
/ Katedra Mikroelektroniki i Technik Informatycznych
A\ "'l' 90-924 £6dz, al. Politechniki 11  tel. (0)4 26 31 26 45 faks (0)4 26 36 03 27
T e-mail: secretary@dmcs.p.lodz.pl www: http://www.dmcs.p.lodz.pl

PODSTAWY ENERGOELEKTRONIKI
LABORATORIUM

Cwiczenie 2

Falownik rezonansowy szeregowy

W laboratorium nalezy wykona¢ pomiary, o ktorych mowa w paragrafie 3.2 instrukcji. Obliczenia mozna wykona¢ w domu.

Opracowanie:
Tomasz Pozniak
tukasz Starzak

tédz 2006

wer. 5.5.2006



2 Podstawy energoelektroniki

Spis tresci

Lo WWSEQP e 3
2. Podstawy teOretyCZne...... ..o 4
2.1, WPTOWAAZENIE ...ttt 4
2.2. Zasada dziatania falownika szeregowego — ukltad podstawowy ...........ccccccvrrnnnncc. 4
Opis dziatania uktadu ... 4
Parametry obwodu reZonansowego ... 6
Czas dysponowany na wylaczenie..........ccccocoeiruiininiiiiinicinniccccccees 7
2.3. Uklad zmodyfikowany falownika szeregowego ...........ccccccviviiiininiiiiininiicininiiciinns 7
2.4. Wspotczynnik zawartosci harmonicznych ..o, 10
3. Badanie uktadu ..o 12
3.1. Uklad pomiaroWy ..ot 12
3.2, Program badan.......ccccooiiiiiiiii s 13
3.3. Opracowanie WYNIKOW .........cccocruriiiiiiiiciicce s 15
Wplyw parametréw obwodu reZonansowego ...........ccccvceeiniccniniceninieisinneens 15
Wplyw czestotliwosci pracy falownika ... 15
4. Oczekiwana zawartos¢ Sprawozdania ..........ccoccueueueiriicciiieincce s 17
LIteratura.....c.cuoviiiiciiicc 17

© Katedra Mikroelektroniki i Technik Informatycznych Politechniki Eodzkiej



Cwiczenie 2. Falownik rezonansowy szeregowy (5.5.2006) 3

1. Wstep

Celem ¢wiczenia jest poznanie zasady dzialania jednego z typowych ukladow
przeksztaltnikowych AC/DC (falownikéw). Przykladowy uklad stanowi niezalezny
falownik rezonansowy szeregowy, w ktérym role kluczy pelnia poétsterowalne przyrzady
potprzewodnikowe mocy — tyrystory. Badania uktadu dotycza wplywu elementéw obwodu
rezonansowego i parametréow sterowania na prace ukladu jako calosci oraz na warunki
pracy tyrystoréw. Na podstawie wynikdw analizy widmowej dokonywana jest ocena jakosci
pracy uktadu w zaleznosci od parametréw sterowania.

Niniejsze ¢wiczenie nie wyczerpuje zagadnienia przeksztattnikow DC/AC. Istniejg inne
rozwigzania falownikdw rezonansowych, jak réwniez falowniki inne niz rezonansowe (np.
falowniki impulsowe). Ich szczegélowa analiza wykracza jednak poza zakres niniejszego
laboratorium.
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4 Podstawy energoelektroniki

2. Podstawy teoretyczne

2.1. Wprowadzenie

Falowniki szeregowe sa urzadzeniami stuzacymi do przeksztatcania napiecia statego na
prad przemienny. Przeksztaltniki te nazywane sa falownikami niezaleznymi i, w
odréznieniu od falownikow sieciowzbudnych (zaleznych), nie maja potaczenia od strony
wyijscia ze sztywna siecig energetyczna.

Falowniki szeregowe znajdujq zastosowanie m.in. w grzejnictwie indukcyjnym, technice
ultradzwigkowej, napedach elektrycznych, uktadach przetwarzania napie¢ itp.

2.2. Zasada dzialania falownika szeregowego - uktad podstawowy
Opis dziatania uktadu

Podstawowy uklad szeregowego falownika rezonansowego przedstawiony jest na rys. 1.
W ukladzie tym odbiornik (przyjmijmy, Ze reprezentuje go opornik R) wchodzi w sktad
szeregowego obwodu rezonansowego. Warunkiem poprawnej pracy falownika jest, aby
obwdd RLC byt obwodem drgajacym, co sprowadza si¢ do warunku

2\E>R. (1)

Zasade pracy ukladu obrazuja podstawowe przebiegi przedstawione na rys. 2.
Przyjmijmy, ze w chwili t = 0 oba tyrystory sa wylaczone, a na kondensatorze odtoZone jest
pewne ujemne napiecie uc = -Ux. Wobec tego w ukfadzie nie ptynie zaden prad i napigcie na
tyrystorze T2 jest rOwniez rowne —Ux, w zwigzku z czym napigcie na tyrystorze Ti

T1
Vi, L R
E — YY" 1
Vi,
Uktad [~ i,
sfeFUJacy—>—§Z 0, =—=C|u
T
2
[

Rys. 1. Uktad podstawowy szeregowego falownika rezonansowego

W chwili t1 ukfad sterujacy generuje impuls bramkowy ici dla tyrystora Ti, co powoduje
jego zalaczenie i przeptyw pradu odbiornika io=im w obwodzie E-Ti-L-R-C. Pod
warunkiem spetnienia nieréwnosci (1), prad ma ksztatt sinusoidy, a jego przepltywowi
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Cwiczenie 2. Falownik rezonansowy szeregowy (5.5.2006) 5

towarzyszy przeladowanie rezonansowe kondensatora C do —jak mozna obliczy¢ — napiecia
E+Ux. Jezeli przyjmiemy, Ze napiecie na przewodzacym tyrystorze T1 wynosi 0, na drugim
tyrystorze odktada sie¢ pelne napiecie zasilania E.
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Rys. 2. Przebiegi napiec i pradéw w uktadzie z rys. 1

Ogodlnie rzecz biorac, w szeregowym obwodzie RLC o charakterze oscylacyjnym prad
ma ksztalt sinusoidy o malejacej amplitudzie. Jednak w przyblizeniu w chwili f2 — przejscia
pradu i. przez zero — tyrystor T1 wylacza sie, co wynika z zasady jego dziatania, i w uktadzie
przestaje ptynac prad. Jezeli przez T oznaczymy okres drgan wiasnych obwodu RLC, to czas
przeptywu pradu odbiornika wynosi T/2, gdyz odpowiada on jedynie potéwce sinusoidy. Po
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6 Podstawy energoelektroniki

ustaniu przeplywu pradu kondensator C podtrzymuje napigcie E+Ux, ktore wystepuje
rowniez na tyrystorze T2. Napiecie um wynosi wiec E-ur2 = —U.x.

Uktad sterowania dziata z pewna czestotliwoscia fs =1/Ts. Po uptywie potowy okresu
sterowania Ts, w chwili ts generowany jest impuls ic2 wyzwalajacy tyrystor T2. Prad io = —im
plynie teraz w obwodzie C-R-L-T.. Podobnie jak poprzednio ma on ksztalt potowki
sinusoidy, jednak ptynie w przeciwnym kierunku. Czas trwania ujemnej potéwki pradu
wynosi oczywiscie T/2, po ktorym to czasie — w chwili t+ — tyrystor T> wylacza sig. Z
przeptywem pradu zwiazane jest przeladowanie kondensatora do napigcia —Ux. Napiecie to
jest podtrzymywane do chwili ts. W tym czasie ur2 = —Ux, ur = E+Ux.

W chwili ts, po uptywie czasu Ts/2 od chwili ts i Ts od chwili 1, uktad sterujacy generuje
kolejny impuls bramkowy dla tyrystora Ti i caly cykl zaczyna si¢ od poczatku. Wynikiem
dziatania uktadu jest wiec przeptyw pradu odbiornika i na przemian dodatnimi i ujemnymi
potowkami sinusoidy. Pomiedzy kolejnymi potéwkami sinusoidy wystepuja przerwy o
czasie trwania

/ 3)

ktory nazywany jest czasem opdznienia przerzutu.
Parametry obwodu rezonansowego

Obwdd drgajacy RLC mozna opisa¢ za pomoca dwdch podstawowych parametrow:

* pulsacji drgan wlasnych niettumionych
0 == @
" JLe
* oraz wspofczynnika ttumienia

a=—. (5)

Obwod moze tez by¢ scharakteryzowany przez:

*  wzgledny wspdtczynnik ttumienia

aw=1=5\ﬁ, ©)
o, 2VL

* pulsacje drgan wlasnych ttumionych

a)=1/a)§—a2 =a)m/1—avzv (7)

=  oraz dobro¢
(8)
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Cwiczenie 2. Falownik rezonansowy szeregowy (5.5.2006) 7

Przeprowadzajac odpowiednie obliczenia, mozna charakterystyczne poziomy napie¢ w
uktadzie uzalezni¢ od parametréw obwodu rezonansowego:

U —E exp(—naw/qll—aé )
l—exp(—ﬁaw/\/l—ai )’

©)

X

E+U, =

(10)

eXP(_ Ty / m ) |

Stad

Uy :exp(—ﬁaw/M). (11)

E+U,

Czas dysponowany na wylqczenie

Aby uklad pracowal poprawnie, na poczatku kazdego potokresu tylko jeden z
tyrystorow powinien zacza¢ przewodzi¢, natomiast drugi powinien pozosta¢ w stanie
blokowania. Jak wiadomo, tyrystory charakteryzuje czas odzyskiwania zdolnosci
zaworowych fq. Jest to minimalny czas, ktéry musi uptynac¢ od wylaczenia tyrystora, aby
mozna byto bezpiecznie ponownie podac na niego napigcie dodatnie. Jezeli napigcie zostanie
podane zbyt wczesnie, tyrystor zalaczy sie mimo braku impulsu bramkowego.

Czas, ktory w konkretnym uktadzie uptywa od wylaczenia tyrystora do ponownego
podania dodatniego napiecia miedzy anoda i katoda, nazywamy czasem dysponowanym na
wylaczenie ta. Warunkiem poprawnej pracy ukladu jest wiec takie dziatanie obwodu
sterowania, aby

1>t (12)

q

Jak widaé na rys. 2, w omawianym uktadzie falownika czas dysponowany na wylaczenie
tyrystora tajest rowny czasowi opdznienia przerzutu top. W tym czasie napigcie na tyrystorze
wylaczanym jest ujemne, natomiast po jego uptywie na tyrystor ten podawane jest dodatnie
napiecie o wartosci E. Warunek (12) ma wigc postac

T, T
op :E_E—Zq/ (13)
stad
I 2T +2t,. (14)

Tak wiec Ts > T, czyli fs < f — czestotliwos¢ pracy uktadu (czestotliwos¢ sterowania) musi by¢
mniejsza niz czestotliwos¢ drgan wiasnych obwodu RLC. To ograniczenie czestotliwosci
pracy od gory jest podstawowa wada rozwazanego uktadu.

2.3. Uktad zmodyfikowany falownika szeregowego
Wady uktadu opisanego w par. 2.2 mozna w znacznym stopniu usuna¢, stosujac cewki
sprzezone o rownych indukcyjnosciach L1 = L2 (rys. 3).
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8 Podstawy energoelektroniki

Rozwazmy dziatanie tego ukladu, rozpoczynajac w chwili, gdy tyrystor T: przestaje
przewodzi¢, a kondensator C jest naladowany do napigecia E+Ux (patrz rys. 4a). Proces
fadowania kondensatora jest analogiczny do opisanego w poprzednim paragrafie. Po
zalaczeniu tyrystora T, prad odbiornika ptynie przez cewke L: indukujac na niej pewne
napiecie. Dzigki wzajemnemu sprzezeniu Li i L2, napiecie powstaje rowniez na cewce Li,
zwiekszajac napiecie wsteczne przytozone do tyrystora Ti, a jednoczesnie zwigkszajac czas
dysponowany na wylaczenie o pewna wartos¢ tx. W zwiazku z tym warunek (12) mozna
zapisac jako

(15)
skad

(16)

Rys. 3. Schemat zmodyfikowanego uktadu falownika szeregowego.

Mozna wigc wigczy¢ jeden tyrystor nim drugi odzyska wtasciwosci blokujace, doktadnie
rzecz biorac — o tx wczesniej. Czas opdznienia przerzutu wymagany dla poprawnej pracy
uktadu, a wiec zachowania ta > tq, jest mniejszy niz w ukfadzie podstawowym. Tym samym
rozwazany uklad moze pracowac z czestotliwoscia sterowania:

* fi<f-najwigkszy czas dysponowany t4, duze znieksztalcenia pradu
odbiornika (rys. 4a);
* fo=f-przypadek dopasowania, najkorzystniejszy ksztatt pradu
odbiornika (rys. 4b);
= f.>f—przebieg pradu prawie prostokatny, duze stromosci pradu i
P &P P P y P
napiecia oraz maty czas dysponowany td (rys. 4c).
Oproécz czasu dysponowanego na wytaczenie ts, warunki pracy tyrystorow okreslaja tez

inne parametry, zaznaczone na rys. 4:

* maksymalne napigcie blokowania Upm — nie moze przekraczac napigcia
przetaczania tyrystora, w przeciwnym razie tyrystor bedzie zataczac si¢
niezaleznie od impulsow bramkowych;

© Katedra Mikroelektroniki i Technik Informatycznych Politechniki Eodzkiej



b)

a)

>
>
>

JAVAVA

1
- - - - - - — o
_ 1 | 2
N 1 1 S
U o vt____] L. °
1 1 | -
1 1 1 had
1 1 1 __Y
Kl t— - - - - ----r-------- a--- -
= 1 1 1 1
=5 1 1 1 1
< < 1 ™N | < \ 1
o (¢} x x bt £ €
S W . = < 2
w
[N 1 1
I 1 1
~ _ 1 1 1
= P 1 1 1
1 1 1
1 / 1 1
< A < 1 < L 1
. o x x = £ £
- ¥ 53 S
E 1
A A A
= =
oy
A
||||| o
1
N 1
= [
[
[ - -
N e I R il e e - == - - = 1
~ [ 1
[ 1
...... > ool L
[ [
I [ [
~ _ 1 [ [
= P 1 [ [
1 [ [
1 // [ [
< y < 1 < [ L1
.—° o x * T OE = x £
3 W U_ UUDW UUR
w w !

© Katedra Mikroelektroniki i Technik Informatycznych Politechniki Eodzkiej

fof>f

Rys. 4. Typowe przebiegi w uktadzie zmodyfikowanym falownika szeregowego: a) fs <f; b) fs
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* maksymalne napigcie wsteczne Urm —jezeli przekroczy napiecie przebicia
tyrystora, przyrzad ulegnie zniszczeniu;

* maksymalna stromos¢ narastania napiecia blokowania (dup/dt)m —
przekroczenie wartosci krytycznej dla tyrystora ma taki skutek jak zbyt
maty czas dysponowany na wytaczenie.

W rozpatrywanym ukladzie stromos¢ dup/dt jest ograniczona w stosunku do ukfadu
podstawowego, w ktédrym napiecie E podawane bylo na tyrystor natychmiastowo.
Natomiast w ukfadzie zmodyfikowanym napiecie na wylaczonym tyrystorze narasta
powoli, gdyz stanowi sume napiecia zasilajacego E i spadkow napiec¢ na cewkach Li i Lo,
bedacych funkcja sinusoidalnie zmiennego pradu odbiornika .. Jest to dodatkowa — oprdcz
zwigkszenia czasu dysponowanego na wylaczenie — zaleta tego ukltadu z punktu widzenia
warunkow pracy kluczy potprzewodnikowych.

Istnieje szereg odmian uktadowych szeregowego falownika rezonansowego. Jedna z nich
pokazana jest na rys. 5. Uklady praktyczne falownikoéw zostaty obszernie przedstawione w
literaturze.

o

Rys. 5. Jedna z wersji uktadu falownika szeregowego

2.4. Wspotczynnik zawartosci harmonicznych

Ogolnie rzecz biorac, zadaniem falownikéw — jako przeksztattnikow DC/AC — jest
generacja przemiennego sygnatu sinusoidalnego. W takim przypadku, aby oceni¢ jakos¢
dziatania ukfadu, nalezy dysponowac jakas miarg podobienistwa generowanego przebiegu
(w rozwazanym ukladzie jest to prad odbiornika io) do idealnej sinusoidy. Takim
parametrem jest wspolczynnik zawartosci harmonicznych dn (ang. total harmonic distortion,
THD). Inne spotykane nazwy tego wspolczynnika to wspodlczynnik znieksztatcen
harmonicznych lub wspoétczynnik odksztatcenia harmonicznymi.

Wspolczynnik zawartosci harmonicznych definiuje si¢ z reguly jako stosunek wartosci
skutecznej obliczonej (ze wzoru Parsevala) z pominieciem pierwszej harmonicznej do
wartosci skutecznej pierwszej harmoniczne;:

dh :_k:Z 7 (17)
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Cwiczenie 2. Falownik rezonansowy szeregowy (5.5.2006) 11

gdzie X® oznacza wartos¢ skuteczna k-tej harmonicznej danego sygnatu x(t). Te definicje
przyjmuja m. in. obowigzujace normy dotyczace jakosci zasilania oraz oddzialywania
odbiornikéw na sie¢ zasilajaca.

W praktyce, gdy korzystamy z cyfrowych przyrzadéw pomiarowych, znane sa wartosci
skuteczne jedynie pewnej skonczonej liczby harmonicznych N. Zachodzi woéwczas
koniecznos¢ stosowania wzoru przyblizonego:

A — (18)

Przyjmuje si¢, ze dla typowych przebiegow wystarczajaca dokladnos¢ osiaga sie dla
N = 40-50.
Jak nietrudno zauwazy¢, dla sinusoidy dn=0, gdyz zawiera ona tylko harmoniczna

podstawowa (pierwsza). Natomiast im wiekszy wspdtczynnik zawartosci harmonicznych,
tym wigksze odksztatcenie przebiegu od idealnej sinusoidy.
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12 Podstawy energoelektroniki

3. Badanie ukfadu

3.1. Uklad pomiarowy

Uktad pomiarowy pozwala na badanie falownika szeregowego w ukladzie
symetrycznym (jak na rys. 5) lub niesymetrycznym (jak na rys. 3 bez cewki Ls).

Przetaczniki umozliwiajg zmiane:
* wartosci indukcyjnosci obwodu rezonansowego L (= L1 = L2),
* wartosci rezystancji odbiornika R,
* Kkonfiguracji (A —niesymetryczna, B — symetryczna).
Uklad jest tak skonstruowany, ze niezaleznie od konfiguracji wypadkowa pojemnos¢ C w
szeregowym obwodzie rezonansowym wynosi 3,75 uF.
Do oscyloskopu nalezy podtaczyc¢:

* dojednego z kanaléw — sygnat z wyjscia uktadu I (pomiar pradu) za
posrednictwem zwyklego kabla koncentrycznego;

* do drugiego kanatu — sygnat z wyjscia U (pomiar napiecia) przez sonde
thumiaca 10:1, przy czym mase sondy nalezy pozostawic nie podtaczona;

* do wejscia wyzwalania zewnetrznego — sygnat z wyjscia Synchr.
Pomiar pradu odbywa si¢ za posrednictwem bocznikéw o wartosci 10 mQ.

Przyciskiem umieszczonym ponizej gniazd I i U wybiera si¢ jedng z dwoch par
przebiegéw do obserwagiji:
* napiecie —uciprad i;
* lub napiecie um i prad —it.
Przycisk ponizej gniazda Synchr. pozwala wybra¢ miedzy wyzwalaniem oscyloskopu

rownoczesnie z wyzwoleniem tyrystora T1 lub réwnoczesnie z wyzwoleniem tyrystora T>. W
niniejszym ¢wiczeniu ustawienie to moze by¢ dowolne.

Pokretto Regq.f stluzy do regulacji czestotliwosci wyzwalania tyrystorow fs. Nalezy
nadmieni¢, ze przy maksymalnym docigzeniu uktadu (wybér R = 0) nastepuje samoczynne
obnizenie czestotliwosci wyzwalania.

Do rejestracji i przetwarzania przebiegéow z oscyloskopu wykorzystuje si¢ program
SP107 dostepny z menu Start, zakladka Pomiary. Pobrania przebiegéw aktualnie
wyswietlanych na ekranie dokonuje si¢ przyciskiem Read. Jezeli zglaszany jest brak facznosci
z oscyloskopem, nalezy skonfigurowac polaczenie wciskajac przycisk Config i Autosearch, a
nastepnie przestawiajac predkos¢ potaczenia na 115200 baud. Zapisu przebiegéw w formie
numerycznej dokonuje si¢ z menu Data » Save, a w formie obrazu — przyciskiem WMF-
Export; obraz mozna réwniez skopiowac do schowka z menu Data » Clipboard.

Zgodnie z instrukcja, wyniki analizy Fouriera zapisujemy w arkuszu kalkulacyjnym. W
laboratorium dostepny jest arkusz kalkulacyjny pakietu OpenOffice. Jezeli przy
uruchamianiu pojawi si¢ informacja o koniecznosci dokonania instalacji, nalezy ja
przeprowadzi¢ zgadzajac si¢ na wszystkie domyslne ustawienia, bez wypetiania danych i
rejestrowania programu. Obstuga arkusza kalkulacyjnego w zakresie potrzebnym na
laboratorium jest identyczna z programem Microsoft Excel. Aby bezproblemowo odczytac
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Cwiczenie 2. Falownik rezonansowy szeregowy (5.5.2006) 13

arkusz w programie Microsoft Excel, nalezy na koniec zapisa¢ go w formacie XLS (menu
Plik, Zapisz jako).

3.2. Program badan

1.

Wprowadzic¢ na oscyloskopie odpowiednie ustawienia:

a) wylaczy¢ uwzglednianie ttumienia sondy 10:1 na kanale, do ktoérego przytaczono
wyjscie I — wcisnac i przytrzymac (do sygnatu dzwiekowego) przycisk AC DC obok
wejscia kanatu (uwzglednianie thumienia jest sygnalizowane wyswietlaniem symbolu
sondy po lewej stronie wzmocnienia danego kanatu);

b) wilaczy¢ uwzglednianie ttumienia sondy 10:1 na kanale, do ktérego przylaczono
sonde napieciowa;

c) sprawdzi¢, czy na obu kanatach ustawione jest sprzezenie DC (sprzezenie DC jest
sygnalizowane przez znak = obok nazwy kanatu na dole ekranu, zas sprzezenie AC —
przez znak ~; zmiany dokonuje si¢ wciskajac (krétko) przycisk AC DC);

d) wybra¢ wyzwalanie z wejscia zewnetrznego (EXT — wybor przyciskiem pod
kontrolkami TRIG.);

e) ustawic tryb wyzwalania wysoka czestotliwoscia HF (przycisk TRIG. MODE);

f) jezeli oscyloskop nie wyzwala si¢ poprawnie (nie swieci si¢ kontrolka TR lub obraz
jest niestabilny), nalezy wyregulowac poziom wyzwalania (pokretto LEVEL);

g) wzmocnienia kanatéw powinny by¢ takie, aby obserwowane przebiegi zajmowaty
mozliwie duza czes¢ ekranu (w trakcie pomiaréw nalezy dopasowywac to
ustawienie do zmieniajacych si¢ warunkow).

W celu eliminacji szuméw widocznych szczegélnie na przebiegu napiecia na boczniku mozna
na oscyloskopie wlaczy¢ tryb usredniania. W tym celu nalezy strzatkami STOR. MODE
wybra¢ AVM, wywota¢ funkcje #AV (wcisnac¢ obie strzatki jednoczesnie), ustawié strzatkami
liczbe probek, z ktérych ma by¢ obliczana srednia, i zatwierdzi¢ wciskajac ponownie #AV.

Ustawi¢ czestotliwos¢ pracy (sterowania) fs < f. Relacje miedzy f a fs nalezy okresli¢ w
oparciu o obserwowane oscylogramy (por. rys. 4).

Podstawe czasu nalezy dobra¢ tak, aby poézniej mozliwe bylo w miare dokladne
zmierzenie odpowiednich czasow (na ekranie widoczne ok. 2 okresy Ts). W razie
potrzeby przebiegi mozna przesuwac¢ o 1/4 ekranu w prawo przyciskiem PTR. (pre-
trigger).

Dla wszystkich 6 kombinacji wartosci R i L, dla konfiguracji A, zarejestrowac wszystkie
dostepne przebiegi napie¢ i pradow przy podstawie czasu jak wyzej i odpowiednich
wzmocnieniach kanaléw. Aby w po6zniejszym czasie mozliwe byto dokladne odczytanie
poziomow napiec i dtugosci odcinkéw czasowych z uzyciem kursoréw programu SP107,
oscylogramy nalezy zapisywac¢ w formacie MES.

Ustawic¢ wartosci L i R wedtug zalecenia prowadzacego (pozostawic konfiguracje A).

Dla 5-6 wartosci czestotliwosci sterowania fs z calego dostepnego zakresu, uwzgledniajac
wszystkie przypadki — fi<f, fs=f i fi>f, zarejestrowal przebieg pradu odbiornika.
Podstawe czasu nalezy dobierac¢ tak, aby widoczne byly co najmniej 4 okresy przebiegu.
Przebiegi nalezy zapisywa¢ w dwoch postaciach: graficznej i numerycznej (plik TAB).
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Dodatkowo dla dowolnego z przypadkow f: <f wyznaczy¢ i zanotowac czestotliwosc¢
drgan wiasnych f.

Uruchomi¢ program Scilab stuzacy do obliczert numerycznych. Wezytaé plik zawierajacy
funkcje potrzebne w niniejszym ¢wiczeniu, wpisujac instrukcje:

exec ("\\ixi\labs\common\pee\falownik.sce');
nastepnie zmienic¢ biezacy katalog na folder zawierajacy zapisane pliki TAB:
cd('dysk:\folder');

W programie Scilab dla kazdego z zapisanych plikéw TAB obliczy¢ widmo amplitudowe
pradu odbiornika w nastepujacy sposob:

a) wczyta¢ wyniki z pliku do macierzy naglowek i dane, wpisujac komende:
[naglowek,dane]=wczytaj spl07('nazwa pliku.tab');

b) za pomoca funkcji fftfal opartej na dyskretnej transformacie Fouriera obliczy¢
amplitudy poszczegdlnych harmonicznych (umieszczajac je w macierzy widmo) oraz
czestotliwosc sterowania fs, wpisujac komende:

[widmo, fs]=fftfal (dane, nr kolumny t, nr kolumny io, ki);

gdzie nr_kolumny_t i nr_kolumny_io oznaczaja numery kolumn w pliku TAB
zawierajagce odpowiednio czas t i napigcie na boczniku ui, natomiast ki jest
mnoznikiem pozwalajacym przeliczy¢ napiecie na boczniku uic na rzeczywisty
warto$¢ pradu odbiornika i.. Kolejnos¢ kolumn w pliku TAB mozna ustalic
wyswietlajac ich nagtowki przez wpisanie:

naglowek
c) odczytac i zanotowac czestotliwos¢ sterowania fs wpisujac:

fs

d) wykresli¢ w postaci stupkéow widmo amplitudowe pradu odbiornika do 40.
harmonicznej wiacznie, wpisujac:

fft wykres(widmo,40);

e) zapisa¢ obraz widma: w oknie wykresu wybra¢ z menu File » Export, a nastepnie
Export Type: GIF.

f) skopiowac obliczone widmo amplitudowe do schowka w postaci tabelki, wpisujac:
fft kopiuj (widmo) ;

g) wklei¢ widmo ze schowka do arkusza kalkulacyjnego OpenOffice.
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3.3. Opracowanie wynikow

Wptyw parametrow obwodu rezonansowego

1.

Na podstawie przebiegow zarejestrowanych w punkcie 3.2.3, w oparciu o znajomos¢
zasady dzialania ukladu, dla wszystkich przypadkéw wyznaczy¢:

a) czestotliwos¢ drgan wilasnych f;
b) czas opdznienia wewnetrznego tv;
c) wartosci napiec¢ Uxi E+Ux;

d) wartosci maksymalnych napie¢ wystepujacych na tyrystorze w kierunku blokowania
Upm i w kierunku wstecznym Urm;

e) maksymalna stromo$¢ narastania napiecia blokowania (dup/dt)m.

W tym celu nalezy zaznaczy¢ kursorami niewielki odcinek (wybrany ,na oko”) po
przejsciu narastajacego napiecia ur przez poziom 0. Stromos¢ oblicza sie jako iloraz
Aup/At, na podstawie obliczonych przez program réznic polozen kursoréw: Aup —
wskazanie ,,CI - CII” dla kanatu zawierajacego przebieg uri; At — wskazanie ,dt”.

Otrzymane wyniki zebra¢ w tabeli.

Na podstawie wynikéow z punktu 1 przeanalizowa¢ wplyw parametréw obwodu
rezonansowego na czestotliwos¢ generowanej sinusoidy.

Wykresli¢ czas opdznienia wewnetrznego tx w funkgcji rezystangji R (na jednym wykresie
dwie krzywe — dla dwu wartosci L). Na tej podstawie okresli¢ wptyw parametrow RiL
na czas fx.

Jak wobec tego zmienig si¢ wymagania co do parametru tq tyrystorow: 1°przy
zwigkszeniu rezystancji w obwodzie? 2° przy zwigkszeniu indukcyjnosci w obwodzie?

Wykresli¢ maksymalna stromo$¢ narastania napiecia blokowania (dun/dt)m w funkcji
rezystancji R dla obu wartosci L (dwie krzywe na jednym wykresie).

Przeanalizowa¢ wpltyw powyzszych parametréw — czy warunki pracy tyrystorow sa
korzystniejsze dla matych czy dla duzych obciazen?

W oparciu o wyznaczone wartosci Ux i E+Ux obliczy¢ wspotczynnik ttumienia aw, a
nastepnie na tej podstawie obliczy¢ dobro¢ obwodu rezonansowego Q. Wyniki doda¢ do
tabeli.

Wykresli¢ zalezno$¢ maksymalnych napie¢ Upm i Urm od dobroci uktadu rezonansowego.
Sformutowac wniosek dotyczacy warunkéw pracy tyrystorow.

Wplyw czestotliwosci pracy falownika

7. Dla kazdego przypadku =z punktu 3.2.5 obliczy¢ wspdlczynnik zawartosci

harmonicznych dn biorac pod uwage N =20 harmonicznych.
Obliczenia najprosciej wykonaé¢ w arkuszu kalkulacyjnym, wpisujac odpowiednia formute z
uzy ciem funkcji SUMA() i PIERWIASTEK() [w wersji angielskiej: SUM() i SQRT()]. Potrzebne

bedzie dodanie nowej kolumny z wyliczonymi kwadratami wartosci skutecznych.

Przeanalizowa¢ wyniki — powiaza¢ obraz przebiegdw w funkcji czasu, obraz widma i
wartos$¢ wspolczynnika zawartosci harmonicznych.
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9. Dla kazdego przypadku wyznaczy¢ stosunek fs/f korzystajac z wartosci f wyznaczonej w
punkcie 3.2.5.

10. Zebra¢ w tabeli uzyskane wyniki f;, fs/f i dv. Wykresli¢ zaleznos¢ wspdtczynnika dn od
stosunku fs/f. Sformutowac wnioski.
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4. Oczekiwana zawartosc¢ sprawozdania

Sprawozdanie powinno zawierac:

* stabelaryzowane wyniki z punktéw 3.3.11i 3.3.5 wraz z przykladami
obliczen;

* wykresy, ich analize i wnioski zgodnie z poleceniami w punktach 3.3.2-
3.3.413.3.6;

= obrazy przebiegdéw zarejestrowane w punkcie 3.2.5 i obrazy widma
zapisane w punkcie 3.2.7;

* tabele z wynikami i wykres z punktu 3.3.10;

* analize wynikdw i wnioski zgodnie z poleceniami w punktach 3.3.8 i
3.3.10.

W katalogu sieciowym zespotu nalezy pozostawi¢ pliki z zarejestrowanymi przebiegami
i uzyskanymi wynikami.
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